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Appendix 

As noted in the main article, DICOM image files cannot be used directly for 3D printing; further 

steps are necessary to make them readable by 3D printers. The purpose of this Appendix is to 

introduce to the readership a set of tools that can be used to convert a DICOM image set into a 

Standard Tessellation Language (denoted by the file extension “STL”) file that is amenable for 

3D printing. This uses a series of simple steps, which were also used in the 3D printing (hands-

on) course at the 2014 annual meeting of the RSNA. 

Some of the initial postprocessing steps may be familiar to the radiologist, as they share 

common features with 3D visualization tools that are used for image postprocessing tasks such as 

3D volume rendering. As in 3D visualization, specific software packages enable segmentation of 

DICOM images using semiautomated and manual segmentation algorithms, allowing the user to 

demarcate desired parts. The most commonly used tools are thresholding, region growing, and 

manual sculpting. In most cases, the initial STL output is not optimized for printing, and further 

refinement is required. This refining step may be unfamiliar even to radiologists versed in 3D 

visualization; CAD software is used to perform steps such as “wrapping” and “smoothing” to 

make the model more homogeneous. 

This Appendix is designed to educate participants about the capabilities of 3D printing 

and to provide an initial working knowledge of how it is performed. A unique feature of this 

Appendix is that the reader is able to download 3D printing software and an anonymized dataset 

from the following Web site: www.RGArticleTraining.com. 

The Web site www.RGArticleTraining.com is maintained, at no cost, by the software 

company Materialise (Leuven, Belgium). At this site, the reader can access a “download” button 

to enable free download of a training version of the software and a dataset of an aorta from the 

authors. The readers can then use this Appendix and the software and data combination to 

segment simple to moderately complicated structures and prepare them for 3D printing. The 

software downloads include “Mimics” and “3-matic,” both applications from Materialise. 

Mimics is an image-processing package that interfaces between 2D image data (eg, CT, MR 

imaging) and 3D engineering applications. 3-matic is a CAD package dedicated for use with 

anatomic data. 

The authors note that neither RadioGraphics nor RSNA endorses any specific 

commercial products. However, the company trade names are inherently part of this Appendix 

because using them is the only way to effectively communicate the educational message. The 

purpose of this Appendix is to meet a large unmet need to train radiologists. There are multiple 

different software packages that can be used to generate STL files that, in theory, can be 3D 

printed. These include commercial products and “freeware.” The readership is encouraged to 

examine all of these options to advance the field of 3D printing among radiologists in general. 

This Appendix reviews the segmentation of an abdominal aorta and the preparation of an 

STL file that can be printed. To do this, the DICOM images must be imported to the Mimics 
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software package. The Web site www.RGArticleTraining.com provides detailed instructions and 

troubleshooting on how to import and manipulate the images. 

This Appendix is divided into Task A, Task B, and Task C. Before we begin task A, we 

will introduce the Mimics software environment, specifically the menus, toolbars, windows, and 

shortcuts. 

Shortcut Action 

Scroll wheel (center mouse) 

OR Shift + right click + drag 

Pan: Move the mouse while keeping the center click pressed 

Ctrl + right click + drag Zoom: Move the mouse vertically while keeping the buttons 

pressed to zoom in and out 

ArrowUp/Scroll wheel up Go to next section (slice) 

ArrowDown/Scroll wheel down Go to previous section 

PageUp Skip 10 sections upward 

PageDown Skip 10 sections downward 

CTRL +  L Make section indicators visible/invisible 

SPACE Zoom window with cursor to full screen 

Backspace Switch between two window states 

Right click + drag on images Adjusts contrast window in images 

Task A. Creating a Mask of (Segmenting) the Aorta 

WHAT YOU ARE DOING: Segmenting the aorta. The term “segmentation” describes the task 

of identifying specific voxels in a region of interest such as the aorta. You will isolate the 

contrast-enhanced lumen of the aorta from the rest of the data in the DICOM images. 

WHY YOU ARE DOING IT: To identify the voxels that will eventually be represented 

in the 3D printed model. 

HOW TO DO IT: The two segmentation tools that will be used are “thresholding” and 

“region growing.” Both may be familiar from experience with standard 3D visualization. 

Thresholding isolates voxels with attenuation within a specified Hounsfield unit (HU) range. In 

region growing, the user manually identifies a seed point, and the software selects voxels within 

the specified HU range that are physically connected to that seed point. 

Each of these steps creates a “mask” or intermediate model that could be printed after 

further manipulations. A list of the masks you have created appears in the first pane of the 

Project Management Toolbar (this is located at the top right of your screen). 

1. From the Segmentation Menu in the top Toolbar, choose Thresholding. This opens a 

window in which you can specify a HU range. This step creates a mask containing only the 

pixels that fall within the specified HU range. 

Set the HU range from 351 to 1399 to eliminate those tissues that fall outside 351–1399 

HU. Bone and the contrast material in the aorta will appear green in the images. 

2. From the Segmentation Menu, choose Region Growing. This tool creates a new mask 

(yellow) containing only those voxels within the source (green) mask that are connected to the 

seed point that you identified. 

http://www.RGArticleTraining.com
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3. Left click on a point within the aorta (from any of the three planes) to specify a seed 

point. This will highlight the aorta and its major branches in yellow, while the rest of the 

highlighted tissue from the previous mask (eg, bone) remains green. Close the Region Growing 

tool. 

The yellow arrow in the screen shot above indicates where you should left click (within 

the aorta) to perform the region growing (step 3 above). 

Hint: Make sure the Multiple Layer option box is selected. This will perform the 

operation throughout the entire image stack. 

4. Next, we will “Calculate” a 3D rendering of the aorta from the yellow mask. This 

intermediate step allows you to visualize the result of the two segmentation steps combined. 

From the Segmentation Menu, choose Calculate 3D. Ensure that the yellow mask is highlighted 

and the Quality is set to Optimal, and hit the Calculate button to create a “3D object.” 

A list of the 3D objects you have created appears in the second pane of the Project 

Management Toolbar (on the right, second from the top in the Project Management Toolbar). 

To adjust the visualization, zoom with the mouse wheel and pan by holding the wheel 

down and moving the mouse. To show the rendering on the full screen, either hover the mouse 

cursor over or click the bottom right image and hit the space bar. The screen can be reset to the 

four-image view by hitting the space bar again. 

After viewing the 3D rendered volume, hide the object by clicking on the eyeglasses in 

the Project Management Toolbar. 

Task B. Editing the Mask of the Aorta 

WHAT YOU ARE DOING: Further segmentation of the DICOM images to remove most of the 

branch vessels, followed by generation of an STL file (a different file format than DICOM that is 

recognized by 3D printers). The STL file then undergoes a smoothing step called “wrapping.” 

WHY YOU ARE DOING IT: The product of each segmentation step we have 

performed thus far could be converted into a STL format and sent to the 3D printer; however, we 

desire to simplify the model and limit the amount of printing material needed by excluding the 

mesenteric branch vessels. 

HOW TO DO IT: The first part of this task uses a third segmentation tool, “Edit Mask in 

3D,” that modifies the volume. This tool is not typically available in standard 3D visualization. 

We will use the Lasso tool from this tool kit to select a small portion of each proximal branch 

vessel near the ostium, which can then be “removed.” This breaks the voxel-to-voxel connection 

between the proximal and distal portions of the individual branches (eg, the superior mesenteric 

artery). Then, after Region Growing is reapplied, the distal branches are no longer rendered. The 

STL file will then be further refined using a smoothing tool called “wrap” that eliminates rough 

areas and gaps in the model. 

Familiarize yourself with the following 3D interface shortcuts that will be used to edit 

your model in 3D: 

Shortcut Action 

Right mouse button Rotate: Move the mouse to rotate 

Shift + Right mouse button Pan: Move the mouse to pan 
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Center click on the mouse 

Ctrl + Right mouse button Zoom: Move the mouse vertically to zoom 

ArrowUp/PageUp Rotate Up with discrete steps 

ArrowDown/Page Down Rotate Down with discrete steps 

Arrow Right/End Rotate Right with discrete steps 

Arrow Left/Home Rotate Left with discrete steps 

1. From the Segmentation Menu, choose Edit Mask in 3D to edit the mask in the 3D 

window. After choosing Edit Mask in 3D, the bottom right image will be the yellow aorta 

surrounded by a 3D transparent box, which indicates the fact that you are editing in 3D as 

opposed to 2D. Hit the space bar to enlarge the view. Click the right mouse button and move the 

mouse to rotate the image, and hold down the scroll wheel to pan the image so that the aorta is 

viewed laterally with the mesenteric arteries pointing to the right of the screen. 

2. Here is an image of the Edit Mask in 3D toolbar that appears at the top of the screen: 

We will use the Lasso tool to select small portions of the mesenteric arteries. Draw a 

loop around the portion you desire to remove. When the loop of the lasso has completely 

surrounded the vessel, the encircled area to be removed will appear as a highlighted area in the 

model. Lasso small proximal portions of the celiac artery, superior mesenteric artery, inferior 

mesenteric artery, and lumbar branches, as well as the midrenal arteries. 

3. Hit the Remove button to disconnect the proximal from distal arteries. This will 

remove that portion of the artery, thereby disconnecting the distal mesenteric branches. Your 

lasso edits need not be perfect. Close the Edit Mask in 3D toolbar, and then hit the space bar to 

return from the enlarged view to the four-window view. 

Hint: The changes that you apply in this operation will only affect the mask information. 

It will not affect any 3D models that you previously calculated. 

4. From the Segmentation Menu, choose Region Growing. Left mouse click within the 

lumen of the aorta (as you did earlier). This will remove the voxels that were disconnected in the 

previous step. There is now a new mask called “Cyan.” Rename this mask “Aorta” by double-

clicking on the name in the Masks tab of the Project Management Toolbar and typing the word 

“Aorta.” Note that at this stage, the bottom right window is empty—we are going to fill it by 

recalculating a new 3D model. 

5. From the Segmentation Menu, choose Calculate 3D. You will see a window that 

allows you to select a Mask and a Quality setting to create a 3D model. Choose your Aorta mask 

and the Optimal setting. Press the Calculate button. 

Note: This calculates a 3D surface model of the region that was highlighted in the 

“Aorta” mask. This model is an STL file that describes the geometry as a set of connected 

triangles. STL is the file format needed to create a 3D printed geometry. This differs from a 

volume-rendered model (ie, 3D visualization) in that it contains exportable surfaces. 

6. Change the color of your model by selecting your Aorta model and clicking on the 

Properties icon on the 3D Objects tab of the Project Management Toolbar. Click on “Artery” in 

the “Type” drop-down menu within the 3D Properties Window. Click “OK.” 

7. From the Tools Menu, choose Wrap to eliminate gaps and smooth rough areas on your 

model. The Smallest Detail in the new window should be set at 0.5 mm; this is on the order of 
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the size of the CT voxel. This will eliminate rough areas representing image noise. The Gap 

Closing Distance should be set at 2.0 mm. The gap closing distance refers to the largest 

separation between points for which anatomic variations will be smoothed. 

Task C. Exporting the Aorta Model to 3-matic (CAD Software) 

WHAT YOU ARE DOING: Exporting the STL file from Mimics to 3-matic to perform the 

final postprocessing steps. In 3-matic, the 3D rendering will undergo one level of smoothing. 

Then the vessel wall will be rendered around the vessel lumen. Finally, we will label the model 

before the final STL file is generated. 

WHY YOU ARE DOING IT: To refine our 3D model to eliminate surface 

imperfections in the 3D printed model. We will create a rendering of the aorta wall rather than 

the opacified intraluminal blood pool so that the printed model can be used for benchtop tasks 

such as evaluation of device deployment or assessment of fluid flow dynamics. The model will 

be labeled for identification purposes. 

HOW TO DO IT: We will export the final iteration of our STL file from Mimics into 3-

matic. In 3-matic, we will perform an additional smoothing step. A rendering of the aorta wall 

will be generated using the “Hollow” tool. We then will visualize the lumen within the hollow 

model after cutting the vessel endings using the “Trim” tool. “Quick label” will be used to apply 

a customized label. 

The screen shot below is displayed to familiarize you with the 3-matic interface. 

1. From the 3-matic Menu in Mimics, choose Design. Select the “Wrapped Aorta” model 

and press OK. This will open the model in the 3-matic software package. 

2. From the Finish Menu, choose Local Smoothing. Set the “Smoothing diameter” 

within the Operations Table to 10 (mm). To smooth out remaining rough areas, zoom in on the 

picture by using the mouse wheel. Then hold the left mouse button down over the region to be 

smoothed while making small circular movements. 

3. From the Design Menu, choose Hollow to create the wall of the aorta. Copy the 

parameters in the screen shot below, and then click “Apply.” It will take some time for this 

operation to finish. 

4. To simultaneously visualize the wall and lumen renderings, right click the Wrapped 

Aorta model in the upper right window called “Scene Tree” and select Transparency > 

Medium. This will demonstrate the wall as a shadowed area around the bright aorta lumen. 

5. From the Finish Menu, choose Trim. Note that at present, the ends of the model are 

“closed,” and the lumen cannot be seen. To open the ends of the model, freehand draw a box (see 

screen shot below) around the proximal aspect of the aorta and press Apply. To completely 

“open” the model, freehand draw additional boxes around the distal aspects of both distal 

common iliac arteries. Press “Apply” after you generate each box to cut each respective portion. 

The resulting model should now be cut open at the ends, enabling visualization of the 

lumen. 

6. Rotate the model sidewise. We are now going to add a label. From the Finish Menu, 

Choose Quick Label. You can label your 3D model with your name and “RSNA 2014” in the 

“Text” box under Label parameters (screen shot below). Change the font height to 3.0000. Click 
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on the model where you would like to place the label (if you press Ctrl while applying the label, 

it will be inset rather than raised off the surface). 

The model will now bear a label with the information you entered. 

7. From the Export Menu, choose Binary STL. Note that this is the step that generates 

the STL file that will be exported to the 3D printer. Define the output directory as the desktop. 
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